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We do the work to make it easy for you! DB MaSter
What is I1t? Computerized filing. -

To help you use a computer to manage the same kind
of information that you keep in card files and filing
cabinets--such as student records, mailing lists,
memberships, research notes, phone numbers, etc.

Who is it for? Two kinds of people.
« new users ... who want to use computers without
having to invest large amounts of money or time.
- those who need a simple filer ... even
experienced computer users sometimes need a
quick, simple, low-cost yet elegant filing system.

Who developed it? Stoneware.
Since 1980, a leader in powerful, computerized filing

systems.

Vital Statisti
Maximum file size: 320,000 characters
Maximum number of fields: 100
Maximum field size: 3,000 characters
Maximum record size: 3,000 characters

Save report designs; produce reports on screen, printer,
or disk (for use with a word processor); print mailing labels;
3 ways to find records; 3 sorts with subtotals per report.
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REGISTERED LICENSEE
AND USER INFORMATION

IMPORTANT

Stoneware has developed this software product and has licensed the
Atari Corporation to market the Atari ST version of this product worldwide.
In no sense are the two firms engaged in a joint venture or partnership.
Because of the nature of the U.S. copyright laws, Stoneware retains
ownership of this software.

Stoneware and Atari have provided to you statements of their warranties
and limitations on warranty and liability. Stoneware has provided to you a
copy of its License Agreement.

These will form a contract between you or your organization and
Stoneware, and between you and Atari. In order to maintain our ownership
of our product, we must insist that you return the attached registration
card. You may not legally use this product until you do so.

TECHNICAL SERVICES

Stoneware provides a range of technical services. One of the most
important of these is technical support. Our technicians are available to
answer questions, either by telephone or by letter, which our users may
have regarding use of our products. If you are interested in our technical
services, please return the registration card. We will send to you
information concerning our technical services.

INFORMATION ABOUT OTHER PRODUCTS

Stoneware has developed a range of products for a number of different
computers. We will develop many more products in the future, including a
number for the Atari ST. We would like to tell you about them, but we
need to know where to send the information.
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UNDERSTANDING
FILE
MANAGEMENT

INTRODUCTION

This chapter is written especially for those of you who are learning for the
first time how to manage information using a computer. We believe that
the most important concepts of computerized filing are the same as
those in paper-based filing systems. The easiest way to learn these
concepts is to clarify the basics about managing information the familiar
way, on paper.

In this chapter, we'll say that you are the librarian of the Happy Valley
School. We will first create a catalog of books. Then, we will describe
what you did that is common to both paper and computerized filing
systems. Each section ends with a few definitions that apply to all filing
systems. These concepts and terms are not limited to DB Master One.

A LIBRARY EXAMPLE
A NEW CARD CATALOG

As the new librarian in the Happy Valley School, the superintendent calls
you into his office on your first day. He says, "We had a fire inthe
library last night, but don't worry, none of the books burned.”

"That's good,” you reply. But soon you discover that what burned was
the card catalog that described each of the 2,000 books and told the
reader where to find it. Your immediate task is to create quickly a new
catalog that contains information to help students find books.

What is that information? For each book, you need: author's name,
book title, publisher, date published, number of pages, type of book,
subject matter, and a special library index number.



On what will

you keep this information? You decide to use small index

cards. Carol in the print shop agrees to produce 2,000 of these cards

overnight.

How will you store these cards? You have visions of note cards spilling
out into the hall where the superintendent will see them. Frank, the
woodworking teacher, offers to build a card file with drawers that will
accommodate the 2,000 cards.

Author:

Title:

Publisher:
Date Published:

Type of book:

Subject:

Index No:

T

Author/Title
CL - COK

B D

Basics

Field

Form

Blank form

What you've done so far is to make a form and a
file. You decided: what information is needed,
what form you would use to store that information,
and how you would store the information once the
form is filled in.

Each kind of information.

The paper (or whatever) on which information is
placed.

A form that has fields placed on it, but does not yet
have specific information filled in.

File A storage device which, at a minimum, has one
blank form, a name, and the capacity to hold a
number of filled-in forms.

Files can be as small as a card box
or as large as a row of filing cabinets.

2,000 CARDS TO FILL IN!

Early the next morning, you meet with Mrs. Brown, who teaches English
Literature, and relate your concern about having to fill in 2,000 cards.
She offers to lend you her class for a day.

Carol delivers the 2,000 blank forms just as you and your "volunteer"
workers arrive at the library. You assign a section of shelves to each
student, and they start filling in the information for each book. Later in the
day, you notice that a student has written in “The Rutabagas of Omar
Khayam." The superintendent would not be amused, so you correct the
card.
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Title: %Esmvm’ oF Cmak. KHauyam
Coverere oRiGwaL E. FitzaeraD “TRAVSLATION
Publisher: pKesPERRe HOUSE
Published: [95
M< Type of book: Remy No. of pages: /59
Subject:
Basics In this section you entered data onto your

forms. You took blank forms and filled them in with
real information. And you changed information
which you knew to be incorrect.

Data Specific information entered on a form.
Record A filled-in form.
Editing Making changes to the fields of a record.

PUTTING YOUR CARDS IN ORDER

One day later all the cards are filled in. Now you have 2,000 cards, in no
particular order. How could anyone find a specific card in that mess?

So you and your volunteers begin sorting the cards into alphabetical
order by the author's last name. Boxes are brought in to hold cards for
each letter of the alphabet, and the students toss the cards into the
appropriate boxes.

The next day, your volunteers first pull out any cards that were put into
the wrong box and then sort the cards in each box into alphabetical
order. Finally, they move the cards over to the cabinet drawers. Now
the filing cabinet is complete!

Basics You organized the records before storing
them in the file. There has to be an order to a
file if people are going to be able to use it.

Sort The process of rearranging records according to the
data in a certain field.

File order The order in which records are stored in a file.

NOW STUDENTS CAN FIND BOOKS!

The library now has an author card file! When Mrs. Brown assigns a term
paper on Shakespeare, you know you're ready to help. Your library has
45 cards for works by Shakespeare. Students can go to the file drawer
marked "SC-SP," flip through the cards, and find all the cards for
Shakespeare.

Snow=_SPa
"l"-llpln.”_
Shad E=Shake
|
= Scott
Author/Title
SC-SP
&e—oo
Basics One of the most important reasons to have a file is
to be able to find a particular record or a
group of records quickly.

Finding records  The process of searching through a file to find one
or more records.



ARE OUR MODERN LITERATURE BOOKS
CURRENT?

To show your appreciation to Mrs. Brown, you ask if there is any
particular information she needs from the new card catalog.

"Definitely," she says. " | want to show the superintendent that the
library needs to update its modern literature collection. So I'd like to
show him all books in the library published after 1960, and how many are
fiction compared to the other types of books."

As the color drains from your face, you mutter, "Two thousand books on
the shelf. Two thousand cards in the file organized by author's last
name."

You are going to have to look at every card in the file to get Mrs. Brown's
information.

At the top of several sheets of paper, you write the different types of
books (fiction, reference, etc.). Then, you divide all the cards among the
volunteers and tell them to look at each card until they find a book
published after 1960. Then, they are to look at the type of book and
write down the author's name, book title, and date of publication on the
appropriate sheet. A day later the task is finished.

"Well," says Mrs. Brown, "l appreciate this list, but | really need the book
titles written down by their date of publication, not by the author's
name."

You spend half of the next day rearranging the list to meet Mrs. Brown's
requirements.

Basics Sometimes you may need to see information from
more than one record at a time. You may need a
listing of certain fields from selected records. And
you may need to have that information sorted
differently than the file order. What you need from
the file is a report.

There are four major things to consider when you prepare a report:

Report fields

Report records

Report sort

Report form

The fields that are included in the report.
(for example: name, title, date of publication, etc.)

The selected records that are used.
(in the example: books published after 1960)

The order in which records are printed.
(by date of publication)

The design or layout of a report.
(in columns)

Author/Title
SC - SP

These are two ways to look at the information
in your files.



CHANGES AND CAUTION

A memo from the superintendent arrives on your desk. He tells you that
a vital piece of information has been left off of the cards. He wants the
date on which the library acquired the book and how it was acquired
(purchased, gift, etc.).

There is no convenient place on your cards to add this new information.
You will have to print up new cards and transfer over all the information
from the old cards.

The superintendent has a second concern. He wants to insure that all
of your commendable work doesn't turn to ashes in case there is ever
another fire.

This issue is easier to resolve, but almost as time consuming. After you
fill in the new cards, you will photocopy all the cards in the file, taking care
to keep them in order so that they don't need to be alphabetized again.
Then, you will put the copies in the storage room of the basement.

Basics No one sets up a file correctly the first time!
Usually, you will have to add and delete fields in
order to make your file what you want. Even then,
you will find that information isn't stable. Your
information needs will probably change over time.
You may even decide to change the file order. You
will have to redesign the file.

A file used in your work often represents a very
significant investment. You will want to copy your
file in case the one you work with gets damaged

and cannot be used.
Redesign Changing the form after it has been set up.
Backup A complete copy of your file.

DB MASTER
ONE
BASICS

INTRODUCTION

This chapter describes a few computer basics you'll use when you start
and leave DB Master One and how to get on-screen help whenever you
need it.

REFERENCE SYMBOLS

In the remaining sections of this manual the following symbols have
been used to make the instructions clear and brief:

LY The pointer (screen location of the mouse).
Place the k on an object.

Click the mouse button once.

Double-Chk Click the mouse button twice quickly.

Hold the mouse button down.

[Poin], and move the mouse, pulling the

object under the k with the mouse.

Save Instructions using menu options show the option in
bold text.

[=] An arrow in the margin points to special notes for
your attention.



USING THE COMPUTER

We assume that you know the basics about using your computer.
Standard operating techniques are covered in the Owner's Manual
provided with your computer.

Changing
screen
resolution

Mouse

Keyboard
commands

lcons

o=

EDIT

P AGE

10

The operating system lets you select different
screen resolutions depending upon the type of
monitor you are using. Files for DB Master One can
be created on low, medium, or high resolution.
When you create a file in one resolution, you cannot
open it using a different resolution setting.

Only the left mouse button is used with
DB Master One.

Most of the menu options can be started directly
from the keyboard instead of with the mouse. The
character A on the screen represents the Control
Key. Hold down [Control] while pressing the letter
shown on the menu. The special function keys are
not used with DB Master One.

DB Master One uses two types of icons to start
different functions in place of keyboard commands.

Menu Help icons: At the bottom of each menu
heading are pictures that represent the functions
available from that menu. the icon to get Help
about the functions of that menu. (Help is also
available by pressing the [Help] key, as described
below.)

Bepont Form icons: Four layouts are available for
producing reports. (See Report Forms in the next
section.) When you are designing a report,
the report form you want before you tell DB Master
One what information will go into the report.

GETTING STARTED

Making a
working copy

Starting
DB Master One

Leaving
DB Master One

Help whenever
you need it!

Use the system disk provided with your computer to
make a working copy of DB Master One.

Instructions for copying a disk can be found in the
Atari ST Owner's Manual under "Making a System
Backup Disk."

As soon as you've made your copy, store the
master program disk in a safe place, away from your
working area. If the working disk becomes
damaged, you'll still have the original from which you
can make another working disk.

Because there are two parts to DB Master One,
there are two ways to start the program:

Making a file: When you are ready to design a new
form, insert the DB Master One program disk. From
the desktop, MAKEONE.PRG and

Open from the File menu. (You can also

the program name to openiit.) Follow

the same steps when you want to redesign a

DB Master Onefile that is already on the disk.

Using a file: To begin adding information to the file,
from the desktop, USEONE.PRG and
Open from the File menu (or the
program name). At the next screen (ltem Selector
Box), the name of the file you want to
use. The file is now open and ready for you to add
or change records and produce reports.

There is only one way to exit DB Master One
properly, whether you have created a new file or are
using an existing one: Quit from the File
menu. If you want to save your work, Yes at
the screen prompt before you exit.

Need help or a reminder about how to use part
of DB Master One? [Help] on the keyboard at

15



Making more
space available
for files

12

any time to get a quick refresher. To select a topic,
the one you want. Flip through all the Help
screens by clicking the buttons marked [More] or
[Back] at the bottom of each screen.

After you have created a file, you can remove
MAKEONE.PRG from the disk to leave more room
for your DB Master One files. You will still have the
master program disk with the original MAKEONE
program to create other files or copy back onto the
disk if you want to redesign the file.

THE
BUILDING
BLOCKS

INTRODUCTION

There are five major building blocks in file management. This chapter will
describe how each of these building blocks are used with DB Master
One. Most of what you will do with DB Master One will be focused on
these five parts:

Field An individual item of information.

Form The screen display on which your fields have been
placed.

File Information stored on identical forms, which have

been saved on the disk and given a name. The file
includes any report designs that have been set up.

Record A form in which data has been entered.

Report Selected information from the file presented visually
in a specified format. Reports can produce
information from certain fields of selected records,
sorted in a specific order.

With DB Master One, these building blocks typically are used in the
following order.

First, decide what fields you want, and place them on the screen where
you want. By placing fields on your screen, you are, in effect, designing
aform. When you save the form, you make afile. Next, open that file
and start adding records by typing in the information you want to save.
You will also use the file to find specific records and possibly to delete
records. After records are stored in your file, you will produce reports.

13




FIELDS

W Desk File Edit Splat Options

M = Design Forn

Label box The first of the two parts of a field, the label
identifies the kind of information that will be typed
in the data box. A field label may be up to 64

characters.

Data box The second part of a field, it holds the specific data
which is typed into the field. The data may be up
to 3,000 characters.

Move box The black box on the lower left edge of the field,

which is used to drag the field to a different place.

Size box The black box on the lower right edge of the field,
which is used to make the data box larger or smaller.

Field style The color, size, and appearance of the label and the
data. Style is set from the Options menu.

14

There are three questions to answer about fields when designing your

form:
1. What fields?

2. What order?

3. Where put?

Write down all of the fields (items) that you will want.

Put the most important field first. The data box in
the upper left hand corner of your screen will be
used to determine how the information is stored.

Fields may be placed anywhere on the screen.
Follow the steps described below.

Fields can contain any kind of information. If fields contain only numeric
data, totals will be calculated automatically in certain kinds of reports.
(See Report Forms in the next section).

Dates

Time

To sort properly, always enter dates: YY-MM-DD.
For example, January 27, 1986 is 86-01-27. You
can use any "separator” (such as "-" or "/"), but
always use the same one. Or use the Date Splat to
create three separate fields. (See the Splat Menu in
the next section.)

To sort properly, enter time as HH:MM and use a
24-hour clock.  For example, 7:45 PM is 19:45.
If you want to sort on hours, make hours and
minutes separate fields.

15




PLACING FIELDS ON THE SCREEN

En e SR O e

=]

Desk File Edit Splat Options

1. where you want a field to start.

2. Type the field label.

3 Options if you want to change label and
data style.

4, and the size box if you want to
change the number of characters that will
fit into the data box.

B and the move box if you want to
move the field.

When you the size or move box, hold the k

on the box until you see that the field has an
“outline" around it.

Three types of fields are available with DB Master One: fields with label
and data, label-only fields, and data-only fields.

Label-only
fields

Data-only
fields

Cut, Copy and
Paste fields

16

Used fortitles. Type in a label. Then the size
box toward the label until the data box disappears.

Used for columns of data. where you want the
field to start. the size box until the data box is
the size you want. Do not type a label.

See MAKEONE: Edit menu in the next section.

FORMS

pMWmu.

Z .
FileNEdit Report Record /

Desk

File order

Long Forms

B:\TRAVEL.ONE

Choosing the information by which your records will
be stored is the most important step in designing a
useful form.

Records are stored in the file based on the first
sixteen characters of data closest to the upper left
corner of the screen. Records are displayed in file
order, including those that match the example you
give when you are looking for a particular group. If
you print an unsorted repont, it will be produced in
file order.

A form can be 100 lines long. To move to fields

which are below the bottom of the screen, use the
scroll bar on the right side of the screen.

17




FILES

A file is created when you save the form that you have been designing.
Every time you save your work on the same disk, the current file is
written over the previous one, completely replacing the previous one.

[21 Save your work often! As you make changes to the file, get in
the habit of saving your work regularly. Save from the File menu
and continue working.

[ Backup your files! At the end of each working session, make a
backup copy of your file. Save the file on your disk. Then, eject that disk
and put your "backup" disk into the drive. Save the file again.

[ Keep a formatted disk handy! If you save a file and learn that

it has grown too big to fit on the disk anymore, just put a new formatted
disk into the drive and Save from the File menu. If you do not

have another formatted disk available, you must delete records until your
file fits on the original disk.

18

RECORDS
_&l;"_/w

pord
Wﬁ% Desk File Edit Report Record

eltic Gaul conquered by Julius Caesar 58-51B.C.

omans ruled forabout 500 years. Long history of monarchy.
renchrevolution 1789-93 succeeded bythe First Republic.
ufferedtremendous|ossesin World Warl.

sintains overseas tenitories in Polynesia, Antarctice,

New Caledonia, etc.

t{foumma,aoo@amm P Aeeond]

You add records to a file by typing information in each field. You must
open USEONE.PRG before you can add information to the file. As you
collect this information, you can find and display all or specific records.

Moving from When filling in the form, [Return] to move

field to field from field to field across the screen. Or in any
field you want . To go directly to fields not shown on
the screen, the scroll bar and then in the
field when it appears on the screen.

Adding, Editing, See the USEONE: Edit menu in the next section.

Finding, and Fields may be left blank. Unfilled spaces in a record
Deleting are not included in the count of characters stored.
FINDING SOME RECORDS

DB Master One provides three ways you can look for particular records.
Also, you can indicate three different examples for each search.

DB Master One then goes through all the records in the file and displays,
in file order, those that match the examples you have entered. It
ignores whether the characters entered are in upper or lower case.

19




To look for particular records from the file, first select a field on which you
are going to search. Then, specify which type of search you will use.
Finally, you enter an example of what you want to find. Repeat these
steps a second and third time if you need to make a more specific search
through the file. The examples below use the Travel file shown in this
manual to find records for specific countries.

Equals

Between

Contains

More than one
match example

20

The first part of a field matches the example.

If you say: Country (field ) equals (type of search)
UN (example),

you will find:  United Kingdom and United States

The data in a field falls in the range between two
examples.

If you say: Country is from SL to TA,
you will find:  Switzerland and Taiwan

The data anywhere in a field includes the match
example.

If vousay: Notes (field) contains monarchy,
you willfind:  Long history of monarchy
(in the record for France)

If examples are in different fields, records must
match ALL examples.

If you say: Continent equals Europe and
Population is from 53.9 million g 60 million,
you will find:  France and Germany

If examples are in same field, record must match
EITHER example.

If you say: Continent gquals North America and
Continent equals South America,
you will find:  Brazil, Canada, and United States

REPORTS

W_&' RPORT I TN

e TEDTEL

NHME 77

Ponuit.

IIRY AITES Page &

t Canitalr i o~

Country Papulation

United Kingdom
United States 2265
West German, y 612

Jan 18, 1986 4 45 PM POPULATION Paget |-,

Grand Totals for 13 records in this repert Maint

Jan 18,1986 4:18PM  COUNTRIES Pages
bt Name - France
7687
8512
9976
1001
547
3288

Continent - Europe

Q0

ench opulation -

| Populat 539

Capital - Paris

seas]

Area - 547

505 TV Sets - 149

244

9363 Notes - Celtic Gaul conquered by Julius Caesar
58-51 B.C. Romans ruled for about S00 years

_______ Leng histery of menarchy. French revolution

1789-93 succeeded by the First Republic
2 Tosses in World War |

erritories in Polynesia,
Antarctica, New Caledonia, etc

(

tolumt
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Reports let you look at information from all or selected records at the
same time. DB Master One allows you to produce reports in any of four
forms. Samples of these four forms are shown above. Reports can be
displayed on the screen, printed, or saved on the disk.

Form

Fields

Records

Sort

Produce reports in any of four forms: Column,
Page, Record, and Mailing List. (See Report Forms
in the next section.)

Two of the forms (Column and Page) require you to
choose which fields are in the report.

Use up to three examples to choose which records
to include in your report when you only want to see
information from a particular group.

DB Master One can rearrange the order in which the
records will be shown in the report.

21




SORTED REPORTS

When no sort order is specified, records are printed in file order. You can

rearrange the order in which records are printed by selecting another field
as the first sort field.

In file order, a column report

shows records for the Travel file

listed alphabetically by country.

Jan 18,1986 4:45PM  AREA Page 1

Country Population Area

24.1 9976
United States 2265 9363
Brazil 1247 8512
Australia 149 7687
700 3208
Mexics 72 1573
Egypt 432 1001
France S35 547
Soain 375 505
Jap. 18 372
taly 574 301
West Germany 612 245
United Kingdom 559 244
15897 4401800

Grand Totals for 13 records in this report

You can even sort your report

i

Jan 18, 1986 4:45PM POPULATION Page |

Country Population Area

-—

Australia 14.9 7687

Brazil 124.7 8512
Canada 241 9976
Eoypt 432 1001
France 539 547
India 700 3288
Mtaly 574 301
Japan 118 32
Mexico 72 1973
Spain 379 sos
United Kingdom 55.9 244
United States 2265 9363
West Germany 612 249

1589.7 44018

Grand Totals for 13 records in this report.

You can,change the sort field to
area, for example, and print a report
listing the countries from the
smallest to the largest in land area.

Jan 18,1986 4:45PM  BY CONTINENT Page 1

records first by the continent and
then from the highest population
to the lowest. In this case you
would get a subtotal when all the
countries of each continent were
listed. By adding these "extras,"
you can have a report that looks
like this:

22

Country Pepulation Area

West Germany 612 249

Ttaly 574 301
United Kingdem 559 244
France 535 S47
e T 379 505
2663 1846.00
Subtotals for S records in CONTINENT of EUROPE'
United States 265 9363
Hits 72 1973
Canada b A RS T
¥226 2131200

588.9 23158.00
Grand Totals for 8 recerds in this report

MENUS
AND
DIALOG BOXES

INTRODUCTION

This section goes screen-by-screen through the two parts of DB Master
One. For easy reference, the page topics are shown in boldface in the

left margin.

Menus

Dialog boxes

and alert
messages

MAKEONE.PRG

The same menu bar is used throughout the process
of creating a new form or changing the design of an
existing form.

Desk File Edit Splat Options

Design fForm S=————-

USEONE.PRG
These menu headings are displayed when you use
the file to manage records and produce reports.

Desk File Edit Report Record

E——=———=Use ONE: B\TRAVEL. ONE e

Dialog boxes function as described in the Atari ST
Owner's Manual. A dialog box appears when

DB Master One needs more information from you
and when you save or choose a file or a report
design.
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Save 48

Quit

- HELP
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MAKE FILE MENU

Desk m“ Splat Options

Design Form S==——=——+

G‘j}’ﬁ ITEM SELECTOR

STOCKS . ONE
TRAVEL . ONE o
PHONES X, ONE Jﬁz“’

lsr DB MM@M{UMMWM

ITEM SELECTOR BOX

New

Redesign

Save

Quit
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New on the File menu to clear the entire
screen so that you can start over.

Redesign to change an existing file. Then,
make changes exactly as you would change a new
form. If fields are deleted, any report designs using
those fields will also be deleted. If the data boxes
of any fields are shortened, you may lose data from
those fields.

Save stores your work on disk (thereby making a
file) and lets you continue. If the disk is full, or if you
want to save the form on a different disk, insert a
new formatted disk, and follow the screen
instructions.

Use Quit to return to the desktop.

Item Selector
Box

How do you get
this box?

File name

File selection

This box appears whenever you name or save a file.
Since it is produced by the operating system, not by
DB Master One, it is possible that this box could
change.

From the MAKEONE File menu, Save or
Redesign. From the USEONE File menu,
Switch Files or Save. This box also appears
when you open USEONE.PRG from the desktop.

Up to 11 characters may be used to name a file, 8
before the "." and 3 after. If you give a formthe
same name as another one already on the disk,
DB Master One will replace the original file with the
current design.

To choose a file for redesign or use, its name

from the listing of files in the Item Selector Box, and
OK. Oryou can [pewie-tic] the file name.

25




W

S\

2

EDIT MENU

fe”

Desk File |IEA Splat Uptiq‘(s

Desk File Edit
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Checkbook
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SPLAT MENU

Cut Field
Copy Field

Paste Field

Cut Text

Copy Text

Paste Text
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Cut removes a selected field from the form.
Use this before Paste to copy a field.

The most recent cut or copied field can be pasted
anywhere on the form. where you want the
field to start, then Paste. You can paste the
same field as many times as you want.

the mouse across the characters in a label you
want to delete and Cut Text.

the mouse across the characters in a label you
want to copy and Copy Text. Use this
before Paste Text to copy text.

in any field label: Then Paste Text to
put the most recently cut or copied text in the label.

Splat

Mailing List

Date

Warthogs

Other Splats

These are ready-to-use fields you can add
anywhere in your forms or use as instant forms.
where you want the Splat fields to begin and
then the Splat name. Splat field labels, sizes,
styles, and placement can be changed.

These fields are set up to print a mailing list. You
can edit them for other kinds of labels. Moving
these fields or changing their size will not affect the
form of the mailing label. If you delete any part of
this Splat, you will not be able to print mailing labels.

Three fields for files with dates that you want to sort
by year, month or day.

This very useful Splat form is for all the itinerant
warthog collectors in the world.

Several other Splats have been provided for your
use. These may change.
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Options
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Field labels and data can be set in different sizes,
colors and text appearance. The field label style can
be different from the data style.

Styles are set from the dialog box shown on the
next page. When you set a style for the field label or
data, the next fields you add will use those settings.
Fields already placed will not change.

Desk File Edit _l]ptiuns

Design Form

CHOOSE LABEL STYLE
SIZE APPEARANCE

‘:’ KEW

(] unDERLIKE
O outLine

STYLE DIALOG BOX

Style Dialog
Box

How do you get
this box?

Color

Size

Appearance

This dialog box is used to set the color, size, and
appearance of the label or the data of a field.

From the MAKEONE Options menu, Label
Style or Data Style.

For color monitors, you may choose the color of the
label and the data.

Select the size of the label and the data. If you
choose a size that does not fit the space available, a
message will appear to tell you that it will not fit.

Text appearance can be mixed in any combination.
Text will be plain unless modified by another
setting. To undo a text appearance setting,
again in the same box.
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These numbers change as you add records to or
delete records from the file.

Switch Files to open a different file than the
one currently in use. the file you want from the
ltem Selector box (described earlier) . If the screen
is not set at the same resolution you used to create
the file, you will not be able to open it.

Save stores your work on the disk and lets you
continue using your file. If the disk is full, or if you
want to save records on a different disk, insert a new
formatted disk and save.

Use Quit to return to the desktop.

EDIT MENU

Cut

Copy

Paste

Clear Field

To remove data from a field, the mouse across
the characters you want to delete and Cut.
Note: You can also delete selected data with the
[Backspace].

Use this with Paste. the mouse across the
characters you want to copy and this option.

where you want to place the most recent cut
or copied text. You can paste the same text as
many times as you want, and you can paste text into
other fields and other records.

Choose a field and this option to erase all the
data in a field.
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REPORT MENU REPORT CONTROL PANEL
Design New Up to ten different report designs may be saved for Report Reports contain four parts: Form, Fields, Find and
later use. This option is more fully described on the Control Panel Sort. After you specify these parts, you give the
following pages. report a name.
Edit You can change or delete existing reports. You may Form What does the report look like? How will the
replace the original design or save both the original information be presented?
and the edited version. Choose the part of the
report you want to change and follow the same Fields Which fields will be printed in the report and in what
procedures as used when designing a new report. order?
Print A report can be printed, displayed on the screen, or Find Which records will be included in the report?
saved on the disk as a text file to be used with a
word processing program. Sort In what order will the records appear in the report?
Saving the After the report parts are specified, whatever
report design you want to do next. A dialog box will appear asking

you to name the report. The report name is printed
as the report title and may be up to 23 characters.
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REPORT FIELDS

The field labels are printed across the top of the
page as column titles. Fields are printed in columns
with one row per record so that data from a number
of records can be presented on one page. A field
may be shortened to fit. Totals are automatically
calculated for numeric fields with 9 digits or less.

Report fields

Field labels are on the left margin of the page, and
the data for each field is printed next to its label. All
of the data in each field is printed. Each record Column fields
printed starts on a new page.

This produces a copy of records which looks like the
form you use on your screen. This is the slowest
report to print. This form will not calculate totals.

You cannot print this form to the screen or store it
on the disk. Page fields
This form is only available when the Mailing List

Splat is included in the file. It is designed to print

standard one-across, six-line, pin-feed labels.

Fields left blank are not printed. This form will not

calculate any totals.

If you choose Record Form or Mailing List, the fields
are automatically set and you do not need to specify
them. If you choose either Column or Page Form,
you need to select which fields go into the report.
the fields in the order you want them to print.

a field again to remove it from the report
design. You cannot add label-only fields to report
designs.

As you the fields for the report, a diagram at
the bottom of the screen shows the width that each
field will be printed. If you choose more fields than
can fit on one line, the last characters of each field
are cut off to make more room. Fields can be
shortened in this manner down to 5 characters.

As you fields for the report, labels for those

fields will be displayed sideways in the order you
choose.
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REPORT RECORDS

Report records DB Master One prints all records in the file unless
you tell it to find a specific group. Find only if
you want your report to include a particular group of
records.

Particular records are selected for reports in the
same way as they are selected for viewing on the
screen. (See Find Records Dialog Box.) Three
methods of finding records are available: equals,
between, or contains. Three examples may be
given per report.
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rint Subtotals
tart New Page

REPORT SORT

Sort field

Sort direction

Subtotals

New page

Sort number

Reports may be sorted by up to three fields. Sort
fields do not need to be included as print fields in
the report. the sort field on the form.

Sorts are normally from low to high numbers and
from letters A to Z based on the contents of the sort
fields chosen. You can reverse the order and sort
from Z to A and highest number to lowest.

Yes if you want to print subtotals. When the
data in the sort field changes, all fields that hold
numbers with 9 digits or less will be subtotaled.

Choose this option if you want to start a new page
when the data in the sort field changes.

When you finish with one sont, the next

number if you want a sort within that sort. You can
review or change other sorts by clicking the number
you want to find.
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Print
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Edit

Delete
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This box appears whenever you select an existing
report design to edit or print. Ten report designs
may be stored.

From the USEONE Report menu: Edit or
Print.

Display the report on the screen. the [Space

Bar] to pause a report and [Return] to stop it.

Send the report to a printer. the [SpaceBar]
to pause a report and [Return] to stop it.

Store the report on the disk for use as a text file.

Choose the report you want to work with.
Edit to modify an existing report design.

Delete to remove a report design from the
file.

gyuds P
s

Desk File Edit Report gi{ziai
Add

RECORD MENU

Add

Find All

Find Some

Next

Previous

Delete

Any time a blank form is displayed on the screen,
you can fill it in and add a record to the file.
Add to put a blank form on the screen. in the
field where you want to add data. [Return] to
move to the next field.

This allows you to look at all records, one at a time.

Find Some when you're looking for one
record or a particular group of records.

Next to see the next matching record in the
file, and repeat this step to see each subsequent
record.

If you want to look again at records you have found,
Previous to back up.

To remove a record permanently from the file, find
the record and Delete.
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FIND RECORDS DIALOG BOX
How do | get This box appears when you Find Some

this box?

from the Record menu.

Choose fields You find particular records by typing in an example

Equals
Between

Contains

40

of what you are looking for. the first field that
has data you want to find. the kind of match
(Equals, Between, or Contains). Type in the
characters you want to match. Repeat these steps if
you have a second and third example. To change
an entry, the number button and go through
the same steps. Erase to delete an

example. Find when you are ready to see

the first record in the group.

The example matches the beginning data of a field.
The data falls within a range given in your example.

The example appears anywhere in the field.

A
Add record, 39

appearance (text), 29

INDEX

Atari ST Owner's Manual, 10, 11

B

Backspace key, 31
backup, 8, 18
basics, 2, 4-8

between search, 20, 40

black box, 14

building blocks, 13-22

C

Clear Field, 31
click, 9

close file (see Quit, Save)

color, 29

Column form, 21, 34, 35
contains search, 20, 40

Control key, 10

Copy, 31

Copy Field, 26

copy disk, 8, 11

Copy Text, 26

count
characters, 19
records, 30

cursor, 19

Cut, 31

Cut Field, 26

Cut Text, 26

D
data, 4, 13

erase, 31

numeric, 15
data box, 14

first data, 15
data-only fields, 16
data style, 28, 29
dates, 15

Splat, 15, 27

DB Master One, 9, 11, 19, 21, 23
leaving, 11
MAKEONE, 11, 12, 23
starting, 11
USEONE, 11, 19, 30

Delete record, 40

Delete report, 38

Design New, 11, 32

desktop, 11
dialog boxes, 23
field style, 29

find records, 40
ltem Selector , 25
report name, 38
disk, 18
making more space on, 12
formatted, 18
program, 11
save reports, 32
drag, 9, 26, 31
double click, 9

E

Edit, 26, 31

editing, 4

equals search, 20, 40
exit DB Master One, 11

F

field, 2, 13, 14, 1
blank, 19
color, 29
data-only, 16
dates, 15
delete (see Cut Field)
edit, 4, 31
label, 14, 28
label-only, 16
label style, 14, 28, 29
move box, 14
moving field to field, 19
report fields, 7, 21, 33, 35
not on screen, 19
numeric, 15
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placing, 16
redesign, 24
size box, 14
Splat, 27

style, 14, 28, 28
time, 15
unfilled, 19

file, 2,3, 18

backup, 8
name, 25

New, 24
Redesign, 8, 24
Save, 24

save current, 18
selection, 25
size, 18

file order, 5, 15, 17

unsorted reports, 22

filing systems, 1

basics, 2, 4-8
computerized, 1
paper-based, 1

finding records, 6, 19-20, 36, 39-40

between search, 20, 40
contains search, 20, 40

equals search, 20, 40

more than one example, 20
upper/lower case characters, 19

form, 2, 3, 13, 17

blank form, 3
Column, 21, 34, 35
filled-in, 4

length, 17

Mailing List, 21, 35
Page, 21, 34, 35
Report, 7, 21, 33, 35

GH
Help key, 11

icon, 10

icons

help menu, 10
report form, 10

ltem Selector Box, 11, 25

JK
keyboard commands, 10
keys, 10
Backspace, 31
Control, 10
Help, 11
special function, 10

E

label-only fields, 16
label style, 14, 28, 29

leaving DB Master One, 11

M
Mailing List, 27, 34
form, 21, 34
MAKEONE, 11, 12, 23
match example, 20
menus, 11, 23
MAKEONE, 23-29
USEONE, 23, 30-40
mouse, 9, 10
click, 9
double click, 9
press, 9
drag, 9
move box, 14

N
name, 25
file, 25
report, 33
New , 24
new page, 37
numeric data, 15

(0

open file, 11, 19
operating system, 10, 25
Options, 28

P

Page form, 21, 34, 35
Paste, 31

Paste Field, 26

Paste Text, 26

pointer, 9

Print, 21, 32, 38
new page, 37
subtotals, 37

program disk, 11

Q

Quit, 11, 24, 30

R
record, 4, 7, 13, 19, 39-40
add, 39
count, 30
Delete, 39
Edit, 31
file order, 5
find, 5, 19-29, 36, 39, 40
Next, 39
Previous, 39
report records, 7, 21
Save, 30
sorted, 5
Record form, 21, 34, 35
Redesign, 24
reference symbols, 9-10
report, 7, 13, 21, 32-38
choose, 38
Column form, 21, 34
Delete, 32, 38
Design New, 32
Edit, 32, 38
fields, 7, 21, 33, 35
form, 7, 21, 33, 34
name, 33, 37
Page form, 21, 34, 35
Print, 32, 38
records, 7, 21, 36
Record form, 21, 34
sort, 7, 21, 33, 37
subtotals, 37
title, 33
totals, 15
Report Control Panel, 33
Report form, 10, 21, 33, 34
Report Name dialog box, 37

S

Save, 18, 24, 30

screen resolution, 10

scroll bar, 19

searches, 19
between, 20, 40
contains , 20, 40
equals, 20, 40

more than one example, 20

selected records, 7

sizebox, 14

size field, 14

size text, 29

son, 5, 21, 22, 33, 37
field, 22, 37
direction, 22, 37
number, 37

Splat, 27
Date, 15, 27
Mailing List, 27, 34
Warthogs, 27

style, 28, 29

subtotals, 37

Switch Files, 25, 30

symbols, 9-10

T

totals, 15, 34
time, 15

U

upper case characters, 19
USEONE, 11, 19, 23

VW
Warthogs, 27

XYz
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